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New Features, Feature Enhancements and 
Behavior Changes 
OData Provider 
The OData Provider is now available as a service in Magic xpi. The OData service 
also provides an Entity Helper for the user to define the OData Service structure. 

Encoding Parameter  
The Encoding parameter is now added to the HTTP component. With this, it is now 
possible to control the encoding of the request body for the POST and REST methods of 
the HTTP step.  
 
The Encoding parameter is also added to the File Management component. With this, 
it is now possible to control the encoding of the file written using the Append BLOB To 
File, Create File, and Write File methods. 

Undo and Redo Commands  
Magic xpi now enables you to undo one or more operations in the Flow Editor and 
redo the undone changes. 

Required Licensing 
The Required Licensing menu is now available under the Help menu of the Magic xpi 
Studio. It shows the license features required for the project which is open. 

Flow Editor Enhancement 
The following features are now available in the studio: 

• Copying and pasting multiple steps 
• Inserting a step between a parent of a branch and the branch 
• The Project path link (BP and Flow) in a Data Mapper which allows to navigate 

back to the Flow Editor pointing to the corresponding Data Mapper step 

Magic xpa Runtime Support 
The Connector Builder utility now supports Magic xpa as a runtime technology. This 
option is available for the step as well as the trigger in the Flow Editor.  
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Installation Upgrade 
It is now possible to upgrade the existing installation of Magic xpi 4.5 and higher to 
the Magic xpi 4.7 version. 

Solution Explorer Icon Indication 
The Solution Explorer now displays new icons to indicate the state of the flow. 

Monitor Enhancements 
For the Activity Log table in Magic Monitor, a Step column was added. 
   
For the Filtered Activity Log table, Step, FSID, Root FSID and Flow Request ID columns 
were added along with an Attached Blob button. 

SAPB1 – SLD Server Support 
Magic xpi now offers SAPB1 support for SLD Server. A new property added to the 
resource allows the user to select between the License Server and the SLD Server.  

SharePoint ADFS Support 
The SharePoint Online connector now supports Active Directory Federation Services 
(ADFS). 

Dynamics 365 Support  
Magic xpi was tested and is now compatible to work with Dynamics 365. 

Salesforce Connector Upgrade   
Magic xpi now works with Salesforce API 39. 

WebSphere MQ Resource 
The WebSphere MQ Resource now supports the User ID and Password based 
authentication. 
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InventoryTransferRequest  
The InventoryTransferRequest object is now available as a part of the Magic xpi 
Objects support. 

SAPB1 9.3 support 
Magic xpi now supports SAP B1 9.3 with the MSSQL 2016 database. 

Non-supported Feature 
The SNMP component is no longer supported in Magic xpi. 
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Known Issues 
 If a project is referring to files outside the project folder using the relative path, then 

after migration the references are not restored in the newly created projects. To 
restore the references, open and save all Data Mappers that use the external 
references. To find such Data Mappers, run Checker on the project. 

 When sending an HTTP request with Body (POST/PUT), the content type and 
encoding header should be specified and should match the body content. For 
example, in case we send a POST request with UTF-8 encoded JSON body, we 
should specify the following header: 
Content-type: application/json; charset=utf-8 

 Since Magic xpi 4.7, if the default value of a variable is used, then the spaces will 
be trimmed from the variable value. 

 Since Magic xpi 4.7, at runtime, the default value of a variable will be trimmed as 
per the length defined for it.  
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Fixed Customer Issues 
 

QCR # Description 
132015 WS Deployment failed when the Web Service Server resource used 

environment variables for the server URL, user and password. 
132080 The “Object class violation” error was thrown when using the "@" 

character in the LDAP connection string for assigning a user to a group. 
136870 The FTP component’s Local Change Directory method affected other steps 

from other flows if a Multi Put method with no files to transfer was also 
used in the same step. 

137655 When trying to change a DB Name in the Data Mapper from lower case 
to upper case, the following error appears: "The schema name must be 
unique". 

137796 The script name "mysql_create_db.sql" used for creating tables for the 
internal Magic xpi MySQL database was misleading since it contained 
'db' in the name and it is now named "mysql_create_tables.sql". 

138559 Trying to validate a SharePoint resource with ADFS turned on, resulted in 
an error.  

139741 In the Magic Monitor, the Delete Activity Log function did not clear the log. 
140766 The Delete operation for the HTTP REST Method did not work when the 

HTTP body was empty. 
140889 Logical names used for the DB2/400 library names were translated in the 

SQL statement. 
141431 The 'Save Copy As’ option in the Studio did not give an error regarding 

the maximum length of the project name. 
141685 In the HTTP requester, the arguments of the Date type threw errors when 

the date was entered with a delimiter other than a slash. 
141696 In the HTTP REST method configuration, the 'URL Dynamic Addition' field 

parameter was not long enough. 
141958 The Magic xpi Studio crashed on Windows 2012 R2 Server after some 

period of active usage. 
142412 When multiple libraries were defined with the same DB resource, the 

INSERT statement always added entries into a single library. 
142782 When creating a new resource in the Magic xpi Studio, an error was 

thrown on Windows Server 2012. 
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QCR # Description 
142785 When using a Call Flow schema as a destination in the Data Mapper a 

runtime error was thrown, if the called flow name was identical to some 
other flow name in another Business Process. 

142813 The project failed to start, giving the "SAP B1 component does not exist in 
the project. Magic xpi Server will shutdown." error when the license file 
had the IBSBO feature with the B1 flag set to Y. 

142980 In the clustered mode, the HTTP trigger returned an empty response when 
a request was received by the web requester for the first server, whereas 
the request was handled by the second server. 

143104 An SQL query containing the INSTR clause was malformed at runtime and 
produced incorrect results. 

143162 The Gigaspaces services stopped working after Windows 10 Operating 
System was updated to the Release 15063.138  

143163 In a SharePoint component, the schema names containing blank spaces 
caused runtime errors. 

143184 In the Data Mapper, an XML destination’s output variable contained 
incorrect names for replicated nodes. 

143212 The File Splitter component produced incorrect results when the length of 
the path to the destination folder exceeded 100 characters. 

143266 SSJ service failed when the length of the project name exceeded 27 
characters. 

143311 The configuration dialog for the .NET Utility connector did not populate the 
list of flow variables with their values. 

143327 For a Salesforce resource, OAuth2 authentication failed when the 
Salesforce server was accessed through a proxy server with its own user 
authentication. 

143357 The Studio crashed when a step referring to flow variables was copied 
from one flow and pasted into another flow. 

143572 After migrating a project from Magic xpi 4.5, the user could not define a 
resource for a user component. 

143579 The CallPublic function with a non-character return value caused errors at 
runtime. 

143591 After migrating a project from Magic xpi 4.1 to 4.6 with a configured 
.NET component, the .NET configuration screen would not open. 

143592 The name of the variable was not saved in the .NET component 
configuration screen. 
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QCR # Description 
143641 The Email trigger for an IMAP mail server did not put the attachment from 

the incoming mail into the variable defined in the Arguments XML Location. 
143657 After migrating a project from Мagic xpi 4.0, expressions with custom 

functions failed to work. 
143669 In the Expression Editor, the BlobRemoveBom function was missing from 

the functions list 
143682 The Salesforce connector's Bulk Create operation transferred the data with 

an incorrect encoding. 
143706 When a copy of a project was created with the “Save copy as” option, the 

new name, and the path were not updated in the start.xml. 
143724 The WCF Client resource threw an error “Compiled proxy not found” while 

loading a specific Web service. 
143729 Magic XPI Studio hanged while attempting to remove an XML from the 

Data Mapper source. 
143732 In a Data Mapper, the STRFormat function with arguments referencing 

source nodes caused the Studio to crash when building the project.  
143748 The Update and Create operations for a SugarCRM Trigger failed when 

used with a multi-select custom field. 
143871 When selecting the All option as the owner, the table list showed garbage 

(symbols) for table names. 
144077 The Magic xpi Studio crashed on using the ODBC driver for a Cache 

database. 
144097 Since SAP B1 9.2 PL 05 version, Magic xpi could not establish a 

connection due to changes to the API for the Company object, and the 
license server was defined using the SLDServer property instead of the 
LicenseServer property. 

144158 After migrating a project from Magic xpi 4.1, the calculated values were 
lost when using an XML schema as a destination without defining the 
source in the Data Mapper. 

144189 Replicated nodes of XML schema and their mappings were lost after 
migration. 

144273 In the Java Class Connector, when a method returned a string of over 
15000 characters, the flow crashed at runtime even though the maximum 
length of the string variable was 100000 characters.  

144353 The WCF connector threw an error at runtime for a given service. 
144372 For a specific project, the Text Search feature caused the Studio to hang. 
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QCR # Description 
144420 Appending the data from the subsequent Salesforce connector requests 

gave an incorrect result.  
144431 For Call Flow and Variable default values, the variable was not truncated 

based on its length definition. 
144573 When configuring multiple parameters in the Web service, the buttons at 

the bottom of the configuration dialog disappeared. 
144574 Some sections of the MAGIC.ini configuration file were deleted when 

editing a resource. 
144663 A specific XML schema in a Data Mapper caused the Studio to hang on 

opening the step for editing. 
144683 In a destination Database schema, changing the INSERT statement to 

UPDATE and vice versa caused the mapping to be lost. 
144721 The Logging function threw a runtime error due to an incorrect number of 

arguments. 
144749 In a replicated Destination node, when the Mapper was not opened in a 

separate tab, the Checker returned an error for a valid expression causing 
the build to fail. 

144750 The record level's destination mapped node calculations were missing after 
migrating the projects from Magic xpi 4.1 to 4.5a or 4.6. 

144751 In a replicated Destination node, a condition expression could not be set 
on the first node, whereas it could be set on the replicated one. 

144850 The Unload method for the trigger in the Connector Builder threw an 
exception and failed to work. 

145025 For an HTTP POST method using a Java Web requester, the return HTTP 
Body data was cut. 

145090 In the REST method called by the HTTP component, the header was 
truncated at runtime when the Header Set contained a comma.  

145148 The Bulk Upsert operation in the Salesforce connector threw an error when 
multiple projects ran in parallel. 

145259 For an MSSQL database, the project failed to run and displayed an “Out 
of Memory” error, in a special scenario when the record length exceeded 
32K. 

145290 In the Connector Builder, for a component with a Method interface set as 
default for the step, the result variable was not updated at runtime. 
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QCR # Description 
145310 In the Data Mapper’s Source and Destination panes, AnyOf, AllOf, and 

OneOf clauses for an array item node were not displayed for JSON 
schemas. 

145416 The Include Delimiter property in the Bulk Upsert destination flat file of the 
Salesforce connector was set to No and could not be changed after 
migrating a project. 

145469 Appending an XML context variable successively in a called flow caused 
incorrect results. 

145482 The Sugar CRM Resource failed to Validate/Connect, if the REST Endpoint 
URL had mixed upper and lower case letters in it. 

145594 Some Data Mapper schemas were incorrectly migrated from IBOLT 3.2a 
projects. 

145904 In a Data Mapper, on creating a Flat File > Positional with empty “From” 
property, a garbage character was added to the Flow Variable value, 
after migrating a project from Magic xpi 4.1 to 4.6. 

146036 The SAP R3 Trigger failed to restore its operation when the network was 
disconnected for a longer period of time. 

146040 For AS/400 System, 10 characters long library names were shown 
truncated in the list of libraries for the DB2/400 resource. 

146041 DB2/400 Library name was truncated to 8 characters. 
146093 A specific WSDL could not be loaded into a WCF client or Dynamic AX 

resource and threw the “Compiled proxy not found” error.  
146100 In a Data Mapper's Database schema, the SQL query failed to execute for 

DB2/400 when the concatenation operator was used in the query. 
146119 In the Connector Builder, the resources defined for a user component could 

not be accessed in the Environment Editor. 
146158 SAP R/3 connector threw an error at runtime when the input XML was 

empty. 
146161 When configuring a SAPB1 8.8 step, the server returned an error for a 

valid resource if the logical name used was longer than 30 characters. 
146202 An error was thrown in the Data Mapper while loading a specific schema. 
146245 With XSD Sub Type defined as XML Position Forwarding on the source 

side, the Data Mapper failed to use the INSERT statement for a destination 
database. 

146262 In the Method interface of the HTTP step, the default length of the string in 
the Header Set parameter was insufficient. 
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QCR # Description 
146277 The Replicate All Data method of the Salesforce connector threw a runtime 

error due to an incorrect definition of SObjectType and Field columns in 
the FieldPermissions table. 

146230 The HTTP response did not contain the status code when HttpFramework = 
D was set in the MAGIC.ini file. 

146291 In the documentation for the Salesforce component's XML interface, the 
setRefbyExternalId function was not excluded from bulk operations. 

146296 After migration, the Data Mapper threw an error, “Some of the schema's 
data does not exist or might be invalid”, for a specific scenario. 

146332 When the Salesforce step returned an error at runtime, the resulting XML 
was incorrect. 

146333 When migrating the project, some of the variables did not pass to the 
called flow. 

146342 The Select schema file input line, in the Data Mapper, for the selection of a 
file had an insufficient height for long paths. 

146380 For a date field in the Data Mapper, the custom format was not saved. 
146381 When a scheduled flow was enabled using the Enable Flow utility, the 

scheduler was called twice. 
146494 Changing the default paths for the Resources.xml and Services.xml in the 

Project Properties caused the entries to duplicate and the build to fail. 
146569 The Studio crashed when a Data Mapper's source referred to an invalid 

JSON schema. 
146641 The Update operation in the Dynamics CRM component returned an 

incorrect result XML BLOB with the duplicated nodes. 
146693 In the FTP and Directory Scanner connectors, SFTP HMACs such as hmac-

sha2-512 and hmac-sha2-256 were not supported. 
146747 The WCF Client connector returned a runtime error for a valid request to a 

specific Web service. 
146852 When trying to validate the SAPB1 resource with MS SQL Server 2016 as 

a database, the resource didn’t validate. 
146759 The Data Mapper's SQL wizard resulted in an "Invalid SQL Statement" 

error if a table name contained the SQL reserved word SET. 
146816 A Magic xpi project stopped processing with a warning in the log "Server 

Status is ON HOLD” causing high memory consumption and CPU getting 
maxed when Magic Monitor was left open on both the App Servers. 

146868 The performance of a WCFClient component was degraded. 
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QCR # Description 
146978 The project failed to start when the Resources.xml file was in a read-only 

mode. 
147003 The Magic xpi Debugger did not recognize a breakpoint and therefore, 

did not suspend the flow in a specific project. 
147319 In the Exchange connector, the query operation returned an empty result 

when a folder name contained blank spaces. 
147456 In the WCF Client configuration page, the Service URL containing %20 

instead of a blank space caused an error at the time of loading the 
service. 
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Magic xpi 4.6: New Features, Feature 
Enhancements and Behavior Changes 
OData Connector 
The OData connector enables you to consume OData V4 services. The OData 
connector offers the following: 

 Use of the OData service metadata to automatically generate structures for  
Magic xpi. 

 Support of all CRUD operations including patch. 

 A query builder to build complex queries while still allowing you to manually enter 
and modify queries. 

 The ability to add any HTTP headers to the requests. 

ServiceMax Connector 
The ServiceMax connector provides you with connectivity to the ServiceMax field 
service application. 

Import/Export 
Magic xpi now has Import/Export functionality, providing a convenient way to easily 
save or load project objects. 
You can also import resources and services that you previously created and saved in 
other projects. 

Dynamics CRM Enhancements 
The Dynamics CRM connector now supports the Upsert operation. The connector also 
has a new method interface that supports Querying by FetchXML. 
Since 4.6, by default, both the on-premise and on-demand implementations are .NET-
based. This means that any new functionality, such as the Upsert operation, which was 
added since 4.6, will only work during Runtime on Windows operating systems. 
Before 4.6, the on-premise implementation was .NET-based and the on-demand 
implementation was Java-based. If you want the previous behavior, where the online 
implementation was Java-based, change the value of the new DCRMOnlineSDK flag to 
N. 
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SAP R/3 Connector Enhancement 
The SAP R/3 connector now uses JCO 3.0.15. 

SAPB1 HANA support 
Magic xpi now supports SAP B1 based on the SAP HANA database.  

SAPB1 Services Support 
Magic xpi now supports selected the SAP Business One Messages service. 

HTTP Framework Setting 
The Magic.ini file's [MAGIC_ENV] section now contains the HTTP Framework global 
environment setting, which specifies the underlying HTTP library to be used for the 
HTTP component. This change was done to support TLS1.2 for the HTTP functionality 

Connector Builder Enhancement 
The Connector Builder now has an Endpoint trigger invocation type, which runs 
outside of the Magic xpi engine. 

Project Documentation 
Magic xpi can now generate detailed printable reports of your projects. 

IBM WebSphere® MQ 8.0 Support  
Magic xpi was tested and is compatible to work with the IBM WebSphere® 8.0 
client/server. 

Microsoft® Windows Server 2016 Support  
Magic xpi was tested and is compatible to work with Microsoft® Windows Server 
2016. 
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Known Issues 
 In an upgraded Magic xpi 4.5 or 4.5a project, you cannot modify an existing 

SAPB1 resource to use a SAP HANA database. You need to create a new SAPB1 
resource instead. 

 To use the native Microsoft® ODBC Driver for SQL Server® with the Magic xpi 
Studio, you need to replace the information in the data_types.xml file with the 
information from the data_types_MSSQLODBC.xml file. Both of these files are 
located at: <Magic xpi installation>\Studio. 
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Magic xpi 4.5a: New Features, Feature 
Enhancements and Behavior Changes 
Salesforce Licensing Prerequisites 
To be able to use a Magic xpi license for Salesforce, you have to install the Magic xpi 
monitoring app that is on the Salesforce AppExchange. For information about how to 
do this, see the How Do I Install the Magic xpi Salesforce App? topic in the Magic xpi 
Help. 

Salesforce Monitoring Utility 
You can monitor your Magic xpi environments, view running projects, receive alerts, 
and get chatter notification about various events using the Magic xpi Force.com 
monitoring utility. For information about how to do this, see the How Can I Monitor My 
Project Using Salesforce? topic in the Magic xpi Help. 

Java 8.0 Support 
Magic xpi was tested and is compatible to work with JRE 8.0. 
Note: JRE 8.0 is not supported for Systinet-based Web services (both consumer and 
provider). For the Windows operating system, to use a Web service consumer, you 
can use the WCF client. 

SAP S/4 HANA Support 
Magic xpi was tested and is compatible to work with the SAP S/4 HANA platform. 

Field Type Behavior Change 
Magic xpi does not have a default picture to handle xs:union field types. If your 
schema contains an xs:union field type, you need to add this type to the Default Data 
Format repository. 
During migration, if you had an xs:union field type and it was mapped, after the 
migration process you will get a Checker error letting you know that you need to 
define your xs:union field type. 
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Known Issues 
 Before migrating a project to Magic xpi 4.5a, make sure that all XSD files used by 

the Data Mapper are available in their declared location. 
 The percent sign (%) cannot be used in a database resource password. 
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Magic xpi 4.5 General Information 
Introducing Magic xpi 4.5 
We are delighted to provide you with the new major release of Magic Software’s 
Magic xpi Integration Platform. The new features and enhancements are designed to 
improve your user experience with the new look-and-feel as well as provide additional 
functionality for your integration projects. 
Magic xpi 4.5 is based on Magic xpa 3.1. 

Migrating from Magic xpi 4.1 to Magic xpi 4.5 
The Migration wizard automatically opens when you open an existing .ibs file. 
Note: If the object names in your projects are in the language of your locale (such as 
flow names or variable names in German), the locale of the machine must match the 
locale used in the project when doing the migration. In addition, the magic.ini file’s 
[MAGIC_ENV]ExternalCodePage flag must also match the used locale. 

Steps Required After Migration 
 uniPaaS steps and Component SDK steps that were created in uniPaaS need to be 

migrated manually to Magic xpa. 
 Web Service servers need to be deployed manually after migration. 
 External files need to be copied to the new project's location according to the old 

project's hierarchy. 
 The migration process does not change any .ini files or its values. To use new 

values, after migration, delete or rename the old ifs.ini file and build the project. A 
new ifs.ini file will be created with new values. 

 If you had logical names defined in your Magic.ini file (not in the ifs.ini file), when 
migrating a project add the logical names (environment variables) to the Magic.ini 
or ifs.ini file. If the environment variables are project specific, you can add them to 
the project's ifs.ini file. For non-project specific environment variables, copy them to 
the Magic.ini file. Note that Magic xpi 4.5 is project centric, meaning that the 
Studio loads the environment variables from the ifs.ini file. 

 If the Invoke Flow utility uses an expression containing hard-code IDs, it might not 
point to the correct ID after the migration process, since these IDs may change 
during the migration. It is recommended to use the dedicated functions, such as 
GetFlowID and GetBPID, which calculate the ID at runtime based on the flow or 
business process name. 
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 If the SpecialExpReturnNull flag is not already present in the migrated project's 
ifs.ini file, you should add it to that file's [MAGIC_SPECIALS] section and set it to Y 
to maintain backward compatibility with projects created in earlier versions of 
Magic xpi or iBOLT. This flag maintains backward compatibility when comparing 
a variable that has a Null value to an empty value. 

 If your migrated project has any user-defined components, the folder containing 
them must be copied from its old location to the new location. Any changes to the 
Resource_types.xml and Service_types.xml files that are connected to user-defined 
components must be done manually. 

 JD Edwards World resource definitions should be updated with a library if such 
definitions do not exist. 

 The JD Edwards Enterprise One configuration has been simplified and now uses a 
dedicated class loader. It is no longer required to list all of the jar files in the 
Magic.ini classpath. If you are using the new class loader, make sure to exclude 
the j2ee1_3.jar from the jar folder. Refer to the Configuring the JD Edwards 
Enterprise One Connector topic in the Magic xpi Help for specific instructions.  

 Due to major changes in the Salesforce metadata API, you will have to reconfigure 
the Metadata CRUD method's Update and Delete operations. 

Licensing  
To use Magic xpi 4.5, you need to obtain version 4.x licenses. To obtain Magic xpi 
licenses, please contact your local Magic Software representative. 

Prerequisite Changes 
.NET Framework 
The Studio module of Magic xpi is based on the .NET Framework. The following .NET 
Framework requirements apply: 

 To develop an application using the Magic xpi Studio, you must have .NET 
Framework V4.0 (or above) installed on your machine. 

 For Runtime, the Magic xpi In-Memory Data Grid requester requires .NET 
Framework V4.0 (or above). 

Studio Installation 
The Magic xpi Studio is based on Microsoft Visual Studio, which cannot be started 
from a network folder. Therefore, it is not possible to start the Magic xpi Studio from a 
network folder. 
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Internal Database Changes 
Writing and reading from the internal database is done using JDBC and not by using 
the Magic xpa gateways. Magic xpi provides the JDBC driver (JAR file) for MSSQL 
databases. To work with any of the other databases: 

1. Copy your JDBC drivers to the following folder: <Magic xpi 
4.5>\Runtime\java\DatabaseDrivers. 

2. Configure the database settings in the Runtime\config\datasource.xml file 
to match your DBMS. Make sure that the driverClassName defined in the 
datasource.xml is compatible with the JDBC driver. 
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New Features, Feature Enhancements and 
Behavior Changes 
New and Improved Studio 
The new Visual Studio-based Studio offers an intuitive and user-friendly experience. 
The new Studio offers a variety of enhancements, including: 

 Docking capabilities. 
 A MiniMap to enable you to navigate quickly within long or wide flows. 
 A Toolbox pane that replaces the Components pane. All the Magic xpi 

components and utilities appear in this pane, grouped together under specific 
categories. 

 A Solution Explorer that replaces the Navigation pane. 
 A dedicated Properties pane that displays the properties of whichever part of the 

project that you are parked on. 
 A Settings dialog box that includes the Resource Repository, Service Repository, 

and IFS Settings dialog box from Magic xpi 4.1. This also includes the Magic.ini 
file settings. This can also be accessed as a stand-alone editor, allowing you to 
configure your project without opening the Magic xpi Studio. 

 A combined search functionality. The Find Name and Text Search of Magic xpi 
4.1 were combined into the Find Text dialog box. 

 The copy and paste mechanism has been enhanced, including the support of 
multiple pasting of steps and branches. 

 Non-English characters can be used in the names of business processes, flows, and 
steps, as well as in descriptions. The names of projects, resources, services and 
variables can only be written in English characters or the language of your 
machine. 

Behavior Changes 
 In Magic xpi 4.1, since the Magic.ini file took precedence in the Studio and the 

ifs.ini file took precedence in Runtime, you had to maintain your environment 
variables in both files. Now, in Magic xpi 4.5, the ifs.ini file always takes 
precedence over the Magic.ini file, both in the Studio and in Runtime. 

 The keyboard combination for opening an existing project is now Ctrl+SHIFT+O 
instead of Ctrl+O. The keyboard combination for creating a new project is now 
Ctrl+SHIFT+N instead of Ctrl+N. 

 Inserting a flow or business process is now done using the Project > Add menu. 
 The default project location is now under your My Documents directory, in the 

Magic folder. 
 Setting how the Studio opens is done using the At Startup drop-down list. This is 

accessed by going to the Tools menu, clicking Options, and selecting Startup in the 
Environment section. This is similar to the Startup As property that was available in 
Magic xpi 4.1’s Customize dialog box. 



 

23   
 

 The disabling, enabling, and deactivating of individual flows is now done through 
that flow’s Properties pane. 

 Flow IDs in Magic xpi 4.5 are unique to a specific project, whereas in 
Magic xpi 4.1 flow IDs were unique to a business process. 

 The IFC Model is now available as an option in the XML Properties. It is available 
for components with a static XML interface. 

 The Clear Mode property has been moved to the Project Properties window, and 
can now be used to clear ODS information only. 

 Defining a flat file structure is done using the Lines property. 
 The following functions were added to the Expression Editor: 

o ClientCertificateAdd 
o ClientCertificateDiscard 
o RqHTTPHeader 
o UTCDate 
o UTCmTime 
o UTCTime 

Magic Monitor 
 The Magic Monitor now offers all of the monitor capabilities for Magic xpi, 

including the new support for the Activity Log, ODS, and BAM. 
 In addition, Activity Log messages can now be filtered when working offline. 
 You can click the new Messages History Export button to generate and download 

a zip file containing a CSV file that holds all the messages related to the selected 
project. 

 The Magic Monitor lets you force the immediate invocation of a Scheduler on a 
specific flow, without changing the next trigger invocation time, once the project is 
running again. You do this by selecting Invoke from the Scheduler's context menu. 

 The Magic Monitor allows new drill-down capabilities based on the FSID, Root 
FSID and Flow Request ID.  

Behavior Changes 
 In the Monitor, during runtime, the server deletes all ODS records belonging to a 

completed FSID. In Magic xpi 4.1, these records appeared even when they were 
no longer active. 

 BLOB variables in Save Message steps can now be saved to the file system instead 
of the database. The FILELOCATION column in the ifs_actlog table stores the value 
from the [MAGIC_IBOLT]ActivityBlobFileLocation flag concatenated with the file 
name when the project loads. The BLOB will be shown in the Magic Monitor 
whether it is saved in the BLOB variable or in the file system. If the BLOB is saved 
in the file system, the Magic Monitor will search the BLOB according to the 
FILELOCATION column. When clearing the Activity Log from the Magic Monitor, 
these BLOBs will be deleted whether they are saved to the database or on the disk. 
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Enhanced Connector Builder 
The SDK from previous versions has been enhanced. The new Connector Builder lets 
3GL programmers build, distribute and sell professional looking connectors. The 
Connector Builder offers: 

 The ability to combine steps and triggers in a single connector 
 Out-of-the-box support for the Magic xpi Studio utilities 
 Customizable UI configuration for both steps and triggers 
 Data Mapper support for a dynamic step 
 Java and .NET runtime technology 
 Runtime isolation via a class loader 
 Licensing 
 Encryption 

For an in-depth explanation of how to use the Connector Builder, see the 
Magic xpi Connector Builder PDF in the Magic xpi installation. 

Data Mapper Enhancements 

JSON Support 
The Data Mapper can now work with JSON schemas. 

Default Database Schemas 
 You can now determine which database schema will be loaded by default from the 

cache (offline) and which will attempt to connect to the database in order to refresh 
its structure (online). 

 You can refresh multiple database schemas by clicking the  button on the toolbar 
or by clicking the Edit menu and selecting Refresh Database Schemas. 

WCF Client Connector 
The WCF Client connector generates C# code to access .dll files and schemas for later 
use during runtime. This new connector provides easy and secure access and 
consumption to a large library of services based on this worldwide standard. 

Dynamics AX 2012 Connector 
The Dynamics AX 2012 connector is now offered as a built-in connector in Magic xpi 
4.5. 
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MQTT Connector 
The MQTT connector lets you work with MQ Telemetry Transport (MQTT), a lightweight 
network protocol used for publish-subscribe messaging between devices. 

Dynamics CRM Connector Enhancement 
The Dynamics CRM supports additional authentication types. It is now a .NET 
connector for on-premise Dynamics CRM servers and not a Java connector as in 
previous versions. For online servers, it is still a Java connector. 
Note: When you set the Dynamics CRM resource's Secured Connection property to 
Yes and the Deployment Type to On Premise, set the DCRMAD flag in the Magic.ini 
file's [MAGIC_IBOLT] section to Y. 

SAP R/3 Connector Enhancement 
The SAP R/3 connector enables communication over Secure Network Connections 
(SNC). 

JD Edwards Enterprise One Jar Files 
Magic xpi is now using a dedicated class loader for loading all of the JD Edwards 
Enterprise One jar files. It is no longer necessary to specify these jar files in the 
classpath (either the machine classpath or the Magic.ini classpath) and no longer 
necessary to copy them to the Magic xpi folder. The JDE connector now has a 
dedicated folder for all of its jar files.  

Java Class Connector Jar Files 
When using the Java Class connector, the Studio no longer loads the Magic.ini file’s 
classpath. Instead, you need to list the jar files in the machine's classpath or copy the 
jar files to the runtime\java\lib folder. 

Additional External Services 
 A Flow Enablement service. Now the flow enablement can be defined as an 

external service and can be modified and affect a project without the need to 
rebuild the project. 

 A Scheduler service. Now the scheduler can be defined as an external service and 
can be modified and affect a project without the need to rebuild the project. 
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SFTP Support 
Magic xpi 4.5 offers support for the SFTP protocol in addition to the FTP protocol. 

Salesforce TLS 1.2 Support 
Magic xpi now supports the TLS 1.2 encryption protocol for the Salesforce connector. 

Windows® 10 Support 
Magic xpi was tested and is compatible to work with Windows® 10. 

An Additional Space and Processing Unit 
In addition to the existing MAGIC_SPACE, Magic xpi now includes 

 A MAGIC_INFO space that holds the Activity Log as well as statistics for the 
monitor and ODS data.  

 An MGMirror processing unit, which is responsible for managing the write 
operation of the Activity Log and ODS data to the database. 

Magic xpa User-Defined Functions 
You can now use Magic xpa user-defined functions in Magic xpi. 

Debugger Enhancements 
The Breakpoints and Suspends pane is now accessible during development. 

Behavior Changes 
 Reconnecting the Debugger in the Studio: In Magic xpi 4.5, the Studio will try to 

reconnect when there are connectivity problems between the Debugger and the 
runtime project, according to a number of rules, such as several retries and 
timeouts. In Magic xpi 4.1, for these types of problems, the Studio terminated the 
debugging session.  

 Starting the Debugger is done by pressing F5 instead of SHIFT+F7. 
 When a project is running in Debug mode and the Studio is terminated, after the 

Studio stops publishing that it is alive, the running project will terminate internally. 
This prevents projects in debug mode running without having a studio controlling 
them. In addition, when attaching to a running project and moving it into Debug 
mode, if the Studio stops publishing that it is alive, the project will move back to 
production mode.  
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Error Retry Enhancement   
If the Magic xpi Server does not succeed in executing a step before reaching the retry 
limit, the last error received is now automatically held in the C.sys.ErrorCode context 
variable. This gives you the ability to check, in the next step's condition, if an error has 
occurred. You can clear the error from the variable by using the ifs.ini file’s new 
StepRetryClearError flag. Setting the StepRetryClearError flag to Y will give you the 
same behavior as Magic xpi 4.1 In addition, you can control the delay between retries 
with the ifs.ini file’s new StepRetryDelayTnSec flag.  

Version Control Usage 
Magic xpi supports version control for versioning. If there is a change to the project 
tree you need to get the entire project using the Version Control provider's Explorer. 

Terminology Changes 
The following terms were changed: 

 Services to utilities: This is referring to the Services that were in the Components 
pane in Magic xpi 4.1. 

 The uniPaaS component has been renamed to the Magic xpa component. 
 The System i connector has been renamed to the IBM i connector. 
 The SugarCRM connector has been renamed to the Sugar connector. 
 The Always use the new Picture node property was renamed to Always Use 

Custom Picture. 
 The Exception Handling Flow property in database destinations was renamed to 

Error Handling Flow. 
 The project’s executable extension was changed from .ibs to .mgxpiproj. 
 Compound Level Computation is now called Multi Update. 
 Cross Reference has been renamed to Find Reference. 

Removed Functionality 
The following features are no longer supported in Magic xpi: 

 Rights Repository 
 Security Groups Repository 
 Users Repository 
 Project Packager 
 COM component: In migrated projects, during runtime, the COM triggers will be 

removed. 
 EJB component: In migrated projects, during runtime, the EJB steps will be treated 

as NOP steps and triggers will be removed. 
 Domino component as a trigger: In migrated projects, during runtime, the Domino 

triggers will be removed. 
 W4 component: In migrated projects, during runtime, the W4 steps will be treated 

as NOP steps and triggers will be removed. 
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 ItemField component: In migrated projects, during runtime, ItemField components 
will be removed. 

 Legacy monitor including the ifm.ini file 
 Text Area tool 
 The Find Reference feature is not available for resources and services. To find 

where a resource or service is used, use the Find Text option on the current project. 
 WS bridge 
 SharedValGet and SharedValSet functions 
 Magic xpi 4.5 is no longer compatible with the Windows® 2003 operating 

system. This is because, by default, Microsoft does not support .NET Framework 
4.5.2 (required by Magic xpi 4.5) with the Windows® 2003 operating system. 

 The Project Rename option has been removed. To rename a project, you can use 
the Save Copy As option instead. 

 Object names cannot contain any of the following characters: [space] ~ ` ! @ # , 
% ^ & * - = + ( ) { } [ ] | " ? / \  < >  ;  or more than one dot (.). 

Currently Not Supported Features 
The following features are currently not supported in Magic xpi: 

 Import/Export 
 Printing a project 
 The Customize dialog box 
 UDDI Server 
 JSON schema elements that contain the word: not 
 Topology and Business Process editors  

Known Issues  
The following are known issues in the current version of Magic xpi: 

 When using the Java Class connector, the Studio no longer loads the Magic.ini 
file’s classpath. Instead, you need to list the jar files in the machine's classpath or 
copy the jar files to th runtime\java\lib folder. 

 Currently, Magic xpi supports source control for versioning. When there is a 
change to the project tree you need to get the entire project using the Source 
Control provider's Explorer. 

 Setting the flow to suspended does not automatically check out the flow. 
 The Open with Editor context menu option is not supported for mapper files. 
 Environment variables are not currently supported for the Notes DB resource’s Host 

Name property. 
 The stand-alone editor can only edit resources and services if the resources.xml and 

services.xml files are located in the project's folder. 
 For Numeric pictures, the Picture property in the Node Properties (for Data 

Mappers) can only contain numbers, decimal points and the letter N for negatives, 
such as N12.4. 

 The Validation component's Empty Field method returns a False value when the 
Input Value parameter contains a string with spaces.  
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About Magic Software Enterprises 
Magic Software Enterprises (NASDAQ: MGIC) empowers customers and partners 
around the globe with smarter technology that provides a multi-channel user 
experience of enterprise logic and data. 
We draw on 30 years of experience, millions of installations worldwide, and strategic 
alliances with global IT leaders, including IBM, Microsoft, Oracle, Salesforce.com, and 
SAP, to enable our customers to seamlessly adopt new technologies and maximize 
business opportunities. 
For more information, visit www.magicsoftware.com. 
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